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Chapter 1

Computer Basics
Activity Time

Open the Paint program. Draw a line at the centre using the Line 
tool. On the left side, type ‘What a Computer Can Do’ and on the 
right, type ‘What  a Computer Can’t Do’. Type the points given 
above under the appropriate headings.

 � Speed: Computers work very fast as 
compared to human beings. 

 � Accuracy: Computers can perform 
calculations without making errors. 

 � Storage: We can store a large 
amount of data in a computer and 
use it in future whenever required. 

 � Versatility: A computer can do 
a variety of tasks with the same 
efficiency.

 � Multitasking: Computers can do 
many different things at the same 
time. 

 � Diligence: Unlike humans, a 
computer can work for a very long 
time without getting tired.

 � Computers are not as intelligent as 
humans. 

 � They are dependent on electricity 
for working. 

 � They cannot think by themselves. 
 � They are unable to take decisions 

like humans.

Do it Yourself

Fill in the blanks.
Ans. � CPU stands for Central Processing Unit. It is can be found inside 

the CPU box. It has three parts – Arithmetic and Logic unit, Control 
unit and Memory unit. The CPU is the brain of the computer.

Ans:



9Living with Computers 3 TRM

Do and Learn!

1.	 Fill in the blanks.
Ans. � (a)  A computer is a/an electronic machine.

(b) � Computers can perform calculations without making 
mistakes.

(c)  All parts of the computer work through the CPU.
(d) � Control unit controls the operations of all parts of the 

computer.
(e) � The logical operations of a computer are performed by the 

ALU.

2.	 Tick () the correct option.
	Ans.	 (a)	 A computer takes Input from the user.
	 (i)	 CD			   (ii)	 Input
	 (iii)	 Process			   (iv)	 ALU

(b)	 Computers can do many different things at the same time. 
This feature is called Multitasking.

	 (i)	 Accuracy			   (ii)	 Diligence
	 (iii)	 Multitasking			  (iv)	 Calculating

(c)	 Which of the following can be done with the help of a 
computer?

	 (i)	 Listening to music
	 (ii)	 Typing and sending a letter
	 (iii)	  Watching a movie
	 (iv)	  All of these

(d)	 CPU stands for Central Processing Unit.
	 (i)	 Centralised Public Unit
	 (ii)	 Central Private Unit
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	 (iii)	 Computerised Processing Unit	
	 (iv)	 Central Processing Unit

(e)	 Memory Unit is also called Primary memory.
	 (i)	 Primary memory	 (ii)	 ALU
	 (iii)	 Control Unit			   (iv)	 CPU
3.	 State whether True (T) or False (F).
	Ans.	 (a) A computer is capable of performing many tasks at the 
			   same time.	 T
		  (b)	 Computers work by following the GPO cycle.	 F
		  (c)	 The CPU is attached to the keyboard.	 F
		  (d)	 The CPU is called the brain of the computer.	 T
		  (e)	 Computers are dependent on electricity for working.	 T

4.	 Write any two points for each of the following.
	Ans.	 (a)	 Strengths of computers:
			   Speed, accuracy.
		  (b)	 Weaknesses of computer:
			   1.  They are not as intelligent as humans.
			   2.  They can’t think like humans.
		  (c)	 Applications of computers:
			   1.  Booking railway and airline tickets.
			   2.  Making documents.
		  (d)	 Names of MU:
			   1.  Primary Memory
			   2.  Random Access Memory
		  (e)	 Parts of the CPU:
			   1.  ALU
			   2.  Control Unit
			   3.  Memory Unit
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Computer Time

Open the Notepad program and type the following terms and their 
full names.
	Ans.	 1.	 IPO: Input-Process-output
		  2.	 ALU: Arithmetic and Logic Unit
		  3.	 CPU: Central Processing Unit
		  4.	 CU: Control Unit
		  5.	 MU: Memory Unit

Answers of Suggested Class Activities
	 1.	 (b)  2. (a)  3. (c)  4. (a)  5. (c)

Answers of Worksheet

	 I.  	 Colour the clouds showing ‘Type letters’, ‘Watch movies’ and  
		  ‘Draw pictures’.

	 II.  	 Arithmetic and
Logic Unit

Control Unit Output UnitInput Unit

Memory Unit

	 III.  	 1. Processing Unit.  2. CPU  3. Arithmetic and Logic; Memory; 
Control  4.   CPU
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Chapter 2

Hardware and Software

Activity Time

Colour the hardware with blue colour and the software with green 
colour.

1 2 3 4

5 6 7 8

	Ans.	 Do it yourself.

Let’s Do it!
Identify and write the peripheral device required for each of the 
following tasks.
	Ans.	 1.  Watching a movie with sound:	 Speakers
		  2.  Printing a typed document:	 Printer
		  3.  Recording your voice:	 Microphone
		  4.  Taking a picture and saving it on the computer:	 Webcam
		  5.  Scanning documents into the computer:	 Scanner
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Activity Time
Identify and name the pictures of these storage devices (write full 
forms): 
	Ans.	 1.  CD – Compact Disc
		  2.  Pen drive
		  3.  Hard Disk
		  4.  DVD – Digital Versatile Disc

Do and Learn

1.	 Look at the numbers on the pictures and write the computer 
parts in the crossword puzzle.

	Ans.	
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2.	 Tick () the correct option.
	Ans.	 (a)	� Computer parts that we can touch and feel are called 

Hardware.
	 (i)	 Programs			   (ii)	 Instructions
	 (iii)	 Hardware			   (iv)	 Software

(b)	 Which of the following is not hardware?
	 (i)	 Speakers			   (ii)	 Mouse
	 (iii)	 Cables			   (iv)	 Tux Paint

(c)	 Software refers to all the programs and instructions given 
to the computer.

	 (i)	 Hardware			   (ii)	 Software
	 (iii)	 CD			   (iv)	 Memory

(d)	 Which of the following is a storage device?
	 (i)	 Pen Drive			   (ii)	 Keyboard
	 (iii)	 Printer			   (iv)	 Scanner

(e)	 Joystick is an input device used for playing games.
	 (i)	 Scanner			   (ii)	 Joystick
	 (iii)	 Printer			   (iv)	 Webcam

	 3.	 State whether True (T) or False (F).
	Ans.	 (a)	� The input devices of a computer are called hardware and 

the output devices are called software.	 F
(b)	Paint is computer software.	 T
(c)	A touch screen allows you to give input to a computer just 

by touching the screen with a finger.	 T
(d)	A scanner is an output device.	 F
(e)	Windows is application software.	 F
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	 4.	 Fill in the blanks to complete the words.
	Ans.	 (a)	 S T O R A G E
		  (b) I N P U T 
		  (c) O U T P U T 

(d)	 P E R I P H E R A L 

(e) W I N D O W S

5.	 Write H (Hardware), S (Software) and ST (Storage) for each of 
the following devices.

	Ans.	 (a) Hard Disk: ST

		  (b) Paint: S

		  (c) Speakers: H

		  (d) Mouse: H

		  (e) Scanner: H

Computer Time

Open the Notepad program and type some lines about any five 
hardware devices. Save the document and show it to your teacher.
	Ans.	 Do it yourself.

Answers of Suggested Class Activities
A.	1.	 (a)  2.  (a)  3.  (c)  4.  (b)  5.  (a)
B.	1.	 Hardware  2.  scanner  3.  printer  4.  system  5.  software

Answers of Worksheet

	 I.  	 1. True  2. False  3. True  4. True
	 II.  	 1. (b)  2. (e)  3. (d)  4. (c)  5. (a)
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Chapter 3

Introduction to Windows 10

Computer Time

Start your computer and open the Paint program. Draw an 
interesting colourful picture and save it.
	Ans.	 Do it yourself.

Do and Learn

1.	 Tick () the correct option.
	Ans.	 (a)	� Operating System is the most important software of a 

computer.
	 (i)	 Paint				    (ii)	 Tux Paint
	 (iii)	 Operating System		  (iv)	 Notepad

(b)	 Calculator is not an operating system.
	 (i)	 Windows 8.1		  	 (ii)	 Windows 10
	 (iii)	 Linux			   (iv)	 Calculator

(c)	 The Windows OS was developed by Microsoft Corporation.
	 (i)	 Micromax			   (ii)	 Microsoft
	 (iii)	 Evasoft			   (iv)	 Acrobat

(d)	  is the icon of the Start button.

	 (i)	 Start			   (ii)	 Shut down
	 (iii)	 Sleep			   (iv)	 Close

(e)	 Icons are the small pictures of the programs present on a 
computer.

	 (i)	 Images			   (ii)	 Buttons
	 (iii)	 Icons			   (iv)	 Charms
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	 2.	 Fill in the blanks.
	Ans.	  (a)	�All computers have an operating system, also called an 

OS.
(b)	 The Start button is present on the bottom left side of the 

desktop screen.

(c)	 Mouse Pointer is a small arrow that moves along with the 
mouse.

(d)	 Desktop background is also known as Wallpaper.
(e)	 The long bar at the bottom of the desktop screen is called 

the task bar.

3.	 State whether True (T) or False (F).
	Ans.	 (a)	 GUI stands for Graphical United Interface.	 F

(b)	Windows 10 is an operating system.	 T

(c)	The taskbar is also called wallpaper.	 F
(d)	There can only be one icon present on the desktop 

screen.	 F
(e)	Icons represent the programs or software present in your 

computer.	 T

4.	 Answer the following.
	 (a)	 Give two examples of operating system software.
		  Ans.  1. Windows  2. Linux
	 (b)	 Name three icons present on the desktop screen of your 
		  computer.
		  Ans.  1. This PC  2. Recycle Bin  3. Network
	 (c)	 Where is the Start button located on the desktop screen?
		  Ans.  Bottom–left corner.
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	 (d)	 Name any one item present on the Notification area of the 
		  taskbar.
		  Ans.  The date and time.
	 (e)	 Write the steps to shut down Windows 10.
		  Ans.  After finishing your work, you need to properly shut down 

Windows 10 before switching off the computer. To shut 
down Windows 10, follow these steps:

			   (i)	 Close all the running programs or apps.
			   (ii)	 Click the Start button to open the Start screen.

			   (iii)	 Click the Power button  present to the left of the  
				    Search button on top of the screen. 
			   (iv)	 Select the Shut down option and wait for the computer 
				    to completely shut down before you switch it off.

5.	 Label the following desktop screen of Windows 10.
	Ans.	

Desktop 
Icons

Mouse Pointer

Start Button Taskbar Notification Area

Date and Time

Desktop 
Background
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Computer Time

Let’s do a small activity. Perform the following steps.
	Ans.	 Do it yourself.

Answers of Suggested Class Activities

Desktop 
Icons

Mouse Pointer

Start Button Taskbar Notification Area

Date and Time

Desktop 
Background

Answers of Worksheet
	 I.  	 1.  False  2.  False  3.  True  4.  True  5.  True
	 II.  	 1.  (c)  2.  (d)  3.  (c)  4.  (a)
  III. 	  1.  most important software
		  2.  taskbar.
	  IV. � (a) Windows 95  (b) Windows 8  (c) Windows 7

  (d) Windows Vista  (e) Windows 10
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TESTING TIME 1
(Based on Lessons 1 to 3)

1.	 Complete the following figure showing the working of the 
CPU.

	Ans.	 Arithmetic and
Logic Unit

Control Unit Output UnitInput Unit

Memory Unit

2.	 Write in the boxes provided whether the following components 
are hardware or software.

	Ans.	
COMPONENTS

Notepad Software

Printer Hardware

Headphones Hardware

Operating System Software

Hard Disk Hardware

CD Hardware

Windows Software

Cables Hardware

HARDWARE/SOFTWARE



32 Living with Computers 3 TRM

3.	 Write a line about each of the following.
	Ans.	 (a)	 Start button: Click this button to open the Start screen.
		  (b)	 Taskbar: It contains Start button and Notification panel.
		  (c)	 Icons: Small pictures when double-clicked open software. 
		  (d)	� Mouse Poniter: A small arrow on the screen that moves 

along with the mouse to point at items.
		  (e)	 �Notification Area: The bottom-right corner of the taskbar 

showing the date and time and some other icons.
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Chapter 4

Introduction to MS Word 2013

Let’s Do it!

Read the following text carefully and circle the mistakes.
	y name is Samiksha. I sudy in class 3. my friend’s name is Aastha. 
She is my bst friend. I play with her in skool .

	Ans.	 The corrected text is as follows:
		  My name is Samiksha. I study in class 3. My friend’s name is  
		  Aastha. She is my best friend. I play with her in school.

Do and Learn!

1.	 Tick () the correct option.
	Ans.	  (a)	Which of the following is not a word processor?
	 (i)	 OpenOffice Writer	 	 (ii)	 Tux Paint
	 (iii)	 MS Word				    (iv)	 Google Docs

(b)	 Which of the following can be done in MS Word?
	 (i)	 Typing letters			  (ii)	 Inserting pictures
	 (iii)	 Deleting text			   (iv)	 All of these

(c)	 It contains the Open, Save and Print commands.
	 (i)	 Title bar			   (ii)	 Status bar
	 (iii)	 File tab			   (iv)	 Document window

(d)	  Selecting bar is present on the Left of the document.
	 (i)	 Left			   (ii)	 Right
	 (iii)	 Top			   (iv)	 Bottom

(e)	 Which of the following is not a formatting tool of MS Word?
	 (i)	 Bold			   (ii)	 Underline
	 (iii)	 Undo			   (iv)	 Italic
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2.	 Fill in the blanks.
	Ans.	  (a)	�A word processor is software that is used to type, edit and 

format documents.
(b)	 MS Word 2013 is part of the software package called MS 

Office 2013.
(c)	 A Ribbon has multiple tabs.
(d)	 Correcting your mistakes in typed text is called editing.
(e)	 Making changes in the appearance of text is known as 

formatting.

	 3.	 State whether True (T) or False (F).

	Ans.	 (a)	 Paint is an example of a word processing software.	 F
		  (b)	 The topmost bar on the MS Word window is the
			   Title bar.	 T
		  (c)	 The Status bar is situated on the left side of the 
			   MS Word window.	 F
		  (d)	 We need to select the text before making changes	  
			   to it.	 T
		  (e)	� Bold, Italics and Underline are editing tools of MS Word 

2013.	 F

	 4.	� Write the keyboard shortcuts to do each of the following in 
MS Word 2013.

 	Ans.	 (a)	 Selecting the entire document.	 Ctrl + A
		  (b)	 Starting a new page in the document.	 Ctrl + N
		  (c)	 Copying the selected text.	 Ctrl + C
		  (d)	 Pasting the copied text.	 Ctrl + V
		  (e)	 Undoing the last action.	 Ctrl + Z
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	 5.	 Answer the following questions.
		  (a)	 What is word processing? Give two examples.
		  Ans.  Typing text in a document and making changes in it is 

called word processing. For example:
			    (i) Typing an essay
			   (ii) Correcting errors in the typed text
		  (b)	Write briefly about each of the following:
			       (i)  Quick Access Toolbar   (ii)  Ribbon  (iii)  File tab

		  Ans.	 (i)	 Quick Access Toolbar: This is a small bar on the 
left side of the Title bar. It provides quick access to 
commonly used commands or tools, such as Save, 
Undo, Redo, etc.

			   (ii)	 Ribbon: The Ribbon contains all the commands you 
will need to perform tasks in Word. It has multiple tabs. 
Each tab is divided into groups with several command 
buttons.

			   (iii)	 File Tab: It is a small button present on the left most 
corner of the Title bar. It contains a menu of commands 
like Open, Save, Print, etc.

		  (c)	� Differentiate between editing and formatting giving 
examples of each.

		  Ans.  Making corrections in a document is called editing. For 
example, deleting and inserting text. Making changes in 
the appearance of the document is called formatting. For 
example, bold, italics, underline, etc.

		  (d)	� Namita has typed a paragraph on ‘Save Water’. She 
now wants to make it look better in appearance. Write 
the names of MS Word tools that she would use to do 
the following:

				    (i)	 Bring the heading to bold.
				    (ii)	 Underline the heading.
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				   (iii)	 Italicise the word ‘water’ wherever it appears in the  
					     paragraph.
				   (iv)	 Change the colour of the heading.
		  Ans.	 (i)	 Bring the heading to bold —  Bold
				    (ii)	 Underline the heading —  Underline
			   	 (iii)	 Italicise the word ‘water’ wherever it appears in the 
					     paragraph  —  Italics
				   (iv)	 Change the colour of the heading —  font color
		  (e)	� What is the purpose of the Undo and Redo tools of 

MS Word? Explain briefly with the help of examples.
		  Ans.  Sometimes you may delete some text and realise later 

that you needed it. Do not panic! You can bring back the 
text by using the Undo button located on Quick Access 
Toolbar.

			   You can click the Undo button more than once to undo 
multiple actions.

			   In the same way, you can use the Redo button if you 
accidentally undo multiple actions.

Computer Time

Open Word 2013 and do the following.
	Ans.	 Do it yourself.

Answers of Suggested Class Activities
A. 	1. (a)   2. (b)  3. (b)  4. (c)
B. 	1. Word   2. Title  3. Ribbon  4. Vertical
C. 	1. False  2. True  3. False     4. True

Answers of Worksheet
	 I.  	 1.  MS Word is used to create and edit text documents.
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		  2.  The window of MS Word 2013 has many parts or components. 
They are:

			   	 Title bar: This is the topmost bar of the window. It displays the 
Quick Access Toolbar, name of the software and the name 
of the document.

			   	 Quick Access Toolbar: This is a small bar on the left side of 
the Title bar. It provides quick access to commonly used 
commands or tools, such as Save, Undo, Redo, etc.

			   	 Ribbon: The Ribbon contains all the commands you will need 
to perform tasks in Word. It has multiple tabs. Each tab is 
divided into groups with several command buttons.

			   	 File tab: It is a small button present on the leftmost corner of 
the Title bar. It contains a menu of commands like Open, 
Save, Print, etc.

			   	 Rulers: The horizontal ruler and vertical ruler are located 
at the top and to the left of your document. They help in 
adjusting the margins and spacing of the document.

			   	 Scroll bars:  There are two scroll bars, horizontal and vertical. 
They are used to move up, down, right or left on the screen.

	 	 	 	 Status bar: The Status bar, situated at the bottom of the 
document window, gives information like number of pages, 
number of words, etc., in the opened document. It also 
contains the Zoom slider on the right for zooming in and 
out of the document.

			   	 Document  window: It is the main area where you type the text 
and insert other objects.

		  3.  The horizontal ruler and vertical ruler are located at the top and 
to the left of the document. They help in adjusting the margins 
and spacing in the document.

		  4.  To create a new document in Word, follow these steps:
			  (i)	 Use the Search option from the Start screen to search 

forWord 2013.
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			  (ii)	 Click the Microsoft Word 2013 icon that appears in the  
results list and press the Enter key from the keyboard. 
The MS Word 2013 Start screen (Backstage View) 
appears.

			  (iii)	 Now, select the Blank document option from the Word 
2013 Start screen (Backstage View) to create a new 
blank document.

		  5.  To add new text or to start typing in a new Word document, click 
on the document area. Now, position the cursor at the place 
where you want to type and start typing the text using the 
keyboard. To type to a new line, press the Enter key. To type 
continuous text like a paragraph, just keep typing and the last 
word on the previous line shifts to the next line automatically. 
This feature of a word processor is called Word Wrap.

	 II.  	                                 F C R M S O W U
I L I S A P I N
L O B W V E N D
E S B O E N D O
O E O R E D O V
Y M N D C Q W D
D O C U M E N T
B O L D F T G F
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Chapter 5

More About Paint

Acitivity Time

Match the following.

	Ans.	 1.	 Eraser tool	 (a)	

		  2.	 Color Picker tool	 (b)	

		  3.	 Brush tool	 (c)	

		  4.	 Line tool	 (d)	

		  5.	 Fill with color tool	 (e)	

		  6.	 Polygon tool	 (f)	

		  7.	 Curve tool	 (g)	

Let’s Do it!
	Ans.	 Do it yourself.

Do and Learn!

	 1.	 Fill in the blanks.
	Ans.	 (a)	 Rectangular and Free-form are types of Selection tools.
		  (b)	� You can create a copy of a picture by using the Copy and 

Paste options.
		  (c)	� The Rotate tool can rotate a picture clockwise or anti-

clockwise.
		  (d)	 To skew means to shift a picture to an angle.
		  (e)	� You can use the Flip feature of Paint to turn a picture upside 

down.
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	 2.	 Tick () the correct option.
	Ans.	 (a)	Which of the following actions is not part of Paint?
	 (i)	 Flip			   (ii)	 Resize
	 (iii)	 Click			   (iv)	 Rotate
		  (b)	The   Zoom in   tool makes a picture look bigger.
	 (i)	 Zoom in			   (ii)	 Resize
	 (iii)	 Zoom out			   (iv)	 Size
		  (c)	� To move a part of a picture from one place to another, we 

use the   Copy and Paste   tool.
	 (i)	 Copy and Paste	 (ii)	 Resize
	 (iii)	 Cut and Paste		 (iv)	 Flip
		  (d)	� We use the   Crop   tool in Paint to cut any unwanted part 

of an image.
	 (i)	 Resize			   (ii)	 Flip
	 (iii)	 Zoom			   (iv)	 Crop
		  (e)	The keyboard shortcut to copy a picture or part of it is 
			      Ctrl+C  .
	 (i)	 Ctrl+X			   (ii)	 Ctrl+N
	 (iii)	 Ctrl+C			   (iv)	 Ctrl+Y

	 3.	 State whether True (T) or False (F).
	Ans.	  (a)	You cannot select a part of a picture in Paint	 F
		  (b)	 The Rectangular selection tool can be used to select a 
			   picture of any shape.	 F
		  (c)	 Zoom out enlarges the view of a picture.	 F
		  (d)	� The Resize tool allows you to increase or decrease the 

size of a picture.	 T
		  (e)	 The Skew tool helps to turn a picture upside down.	 F
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	 4.	 Answer the following questions.
	Ans.	 (a)	� Karuna has drawn the night sky with one star.  Which Paint 

tool can she use to create 10 more similar stars without 
drawing them again?

		  Ans.  Copy and Paste.
		  (b)	� John has drawn a scenery with a tree. He wants to reduce 

the size of the tree. Which Paint tool can help him do so?
		  Ans.  Resize.
		  (c)	� Name the different types of selection tools in Paint. Write 

one line about each.
		  Ans.  (i) Rectangular selection: Selects rectangular part of a  

drawing
			      (ii)	� Free-form selection: Allows you to make a selection in 

any shape from the drawing.
	 	 (d)	Write briefly about Zoom tool of the Paint program.
		  Ans.  �Zoom means to increase or decrease the view size of an 

object on the screen. To use the Zoom feature in Paint, 
follow these steps:

			    (i)	 Draw a picture or open an existing one.
			     (ii)	�� Click the Zoom in option in the View tab. The image 

	 will look enlarged.
			   (iii)	 Click the Zoom out option to reduce the view size.
		  (e)	� Which Paint tool do you use to cut an unwanted portion 

from a picture? Write steps to use the tool.
		  Ans. � To use the Crop tool, follow these steps:
			    (i)	 Draw or open a picture in Paint.
			   (ii)	� Use the Select tool to select the area that you want 

to keep out of the picture and click the Crop tool present 
in the Image group.

Computer Time

Open Paint and draw this picture. You may change the colours as per 
your choice. After drawing.
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1.	 Add five more birds in the 
sky.

2.	 Remove five trees from the 
picture.

3.	 Skew the hut slightly.
4.	 Flip the whole picture 

horizontally.
	Ans.	 Do it yourself.

Answers of Suggested Class Activities
A. 	1. False  2. True  3. False  4. True  5. True
B. 	1. (d)  2. (a)  3. (c)  4. (c)  5. (b)

Answers of Worksheet
	 I.  	 1.  Flip  2.  Select All  3.  Image  4.  Flipping  5.  Resize
	 II.  	 1.  Rectangular selection tool  2.  Magnifier tool
		  3.  Color picker tool
		  4.  Select all tool  5.  Free-form selection tool
	 III.	 Rectangle, Line, Polygon, Shapes, Fill with color.
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Chapter 6

Fun with LOGO

Computer Time

Let’s try the following commands in MSW LOGO.
	Ans.	  Do it yourself.

Do and Learn

1.	 Fill in the blanks.
	Ans.	 (a)	� The triangle in the drawing area of the MSW LOGO screen 

is called the turtle.
		  (b)	� The Main Screen of MSW LOGO is also known as Drawing 

area.

		  (c)	 The LOGO primitive FD  moves the turtle forward.

		  (d)	� We must press the Enter key from the keyboard after typing 
a command.

		  (e)	 The command to exit MSW LOGO is BYE.

2.	 Tick () the correct option.
	Ans.	 (a)	 LOGO stands for Language of Graphics Oriented.

	 (i)	 Google			   (ii)	 Graph

	 (iii)	 Graphics			   (iv)	 Geeks

		  (b)	� The window where you type and execute instructions in 
LOGO is the  Commander window.

	 (i)	 Main			   (ii)	 Commander
	 (iii)	 Drawing			   (iv)	 Output
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		  (c)	 Which of the following is not a valid LOGO primitive?

	 (i)	 FD			   (ii)	 RE

	 (iii)	 RT			   (iv)	 LT

		  (d)	 The LOGO command      BK      moves the turtle backwards.

	 (i)	 BK			   (ii)	 FD

	 (iii)	 FORWARD			   (iv)	 BYE

		  (e)	 LOGO language may be used for:
	 (i)	 Drawing			   (ii)	 Calculations
	 (iii)	 Typing words			  (iv)	 All of these

3.	 State whether True (T) or False (F).
	Ans.	 (a)	 In the full form of LOGO, L stands for learning.	 F
		  (b)	 MSW LOGO is a GUI-based version of LOGO.	 T
		  (c)	 To exit LOGO, type the GOODBYE command.	 F
		  (d)	� The RT primitive moves the head of the turtle to the 

left direction.	 F
		  (e)	� All the commands typed in the Command Input Box 

can be seen again in Recall List Box area.	 T

4.	 Answer the following questions.
	 (a)	 What is the full form of LOGO?
		  Ans.  Language of Graphics Oriented.

	 (b)	 Name the different components of the MSW LOGO screen.
		  Ans.  (i) Main screen  (ii) Commander Window

	 (c)	� What is turtle?
		  Ans.  The small triangle in the centre of the drawing area is called 

turtle. It is used as a pen to draw on the main screen.
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	 (d)	� Write the steps to exit LOGO.
		  Ans.  To stop or exit MSW LOGO, follow these steps:
			    (i)  Click the File menu.
			   (ii)  Click Exit.

OR
		�  Type BYE in the Command Input box and press the Enter key 

from the keyboard.
	 (e)	 Name four important primitives of MSW LOGO. Write one  
			  example of each.
		  Ans.  (i)  FD (Forward) : FD 50
			    (ii)	 BK (Back) : BK 100
			    (iii)	 RT (Right) : RT 90
			    (iv)	 LT (Left) : LT 45

Computer Time

1.	 Try the following LOGO commands and draw the output in the 
boxes provided.

	Ans.	  Do it yourself.

2.	 Try drawing the following figures in MSW LOGO. Write the 
commands used in the space provided.

	Ans.	  Do it yourself.

Answers of Suggested Class Activities
A. 	1. (a)  2. (c)  3. (a)  4. (b)
B. 	1. MSW LOGO  2. Title  3. Turtle  4. FD
C. 	1. False  2. False  3. True  4. True
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Answers of Worksheet
	 I.  	 1.  (e)  2.  (a)  3.  (b)  4.  (d)  5.  (c)
	 II.  	 1.  MSW LOGO is a computer language used for drawing. It was 

developed by Seymour Papert.
		  2.	 The Title bar is located on top of the LOGO screen. It displays 

the name of the software.
		  3.	 The small triangle in the centre of the drawing area is called 

turtle.
		  4.	 LOGO commands are called primitives.
		  5.	 The centre position is the home of the turtle.
		  6.	 (i)	 Click the Windows button.
			   (ii)	 Click the down-arrow key on the Start screen and scroll 

down to Microsoft Windows Logo. Alternatively, you can 
search for ‘Microsoft Windows Logo’.

			   (iii)		 Click to open it. The  About MSWLogo window appears.
			   (iv)	 Click the OK button. Now, the actual LOGO screen will appear.
	 III.  	

A SQUARE OF 100 POINTS A RECTANGLE OF 50 BY 100 
POINTS

FD 100    RT 90
RT 90
FD 100
RT 90
FD 100
RT 90
FD 100

FD 50    RT 90
RT 90
FD 100
RT 90
FD 50
RT 90
FD 100
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TESTING TIME 2
(Based on Lessons 4 to 6)

1.	 State whether True (T) or False (F).
	Ans.	 (a)	 MS Word is a drawing program.	 F

		  (b)	 The Status bar in MS Word contains the Zoom slider.	 T
		  (c)	 Rotating a picture in Paint means to remove 
			   an unwanted part from it.	 F
		  (d)	 The Zoom feature in Paint allows you to increase 
			   or decrease the view size of an object on the screen.	 F
		  (e)	 LOGO is a computer language that can be used for 
			   drawing and colouring shapes.	 T
2.	 Match the following.
	Ans.	 1.	 Ribbon	 (a)	Ctrl + A
		  2.	 Document Window	 (b)	Turtle
		  3.	 Editing	 (c)	Contains various  
					    tabs and groups
		  4.	 Select the whole document	 (d)	Main area in MS  
					    Word
		  5.	 LOGO pen	 (e)	Doing corrections

3.	 Write the functions of the following LOGO commands:
	Ans.	 (a)	 FORWARD: Moves the turtle in forward direction.
		  (b)	 BACK: Moves the turtle in the backward direction
		  (c)	� RIGHT: Turns the head of the turtle towards the right 

side.
		  (d)	 LEFT: Turns the head of the turtle towards left side.
		  (e)	 BYE: Exits LOGO.
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4.	 Draw the output of the following LOGO commands:

	 A. Label the parts of the LOGO window.
		  (a)	 FD 50
			   RT 90

			   FD 50

			   LT 90

			   FD 50

			   RT 90

			   FD 50

		  (b)	 BK 30
			   LT 90

			   BK 30

			   RT 90

		  	 BK 30

Ans. Do it yourself.
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Chapter 7

More About LOGO

Let’s Do it!

Fill in the blanks to complete the commands to draw a square with 
each side of 70. Remember not to use the RT command in this!
	Ans.	 Do it yourself.

Computer Time

Try the following commands in MSW LOGO and draw the output 
in the space provided.
	Ans.	 Do it yourself.

Let’s Do it!

Follow the steps given in the box to learn this command. Compare 
the output drawing with the command.
	Ans.	 Do it yourself.

Let’s Do it!

Let’s draw a square and then erase it completely by trying these 
commands.
	Ans.	 Do it yourself.

Do and Learn

1.	 Fill in the blanks.
	Ans.	 (a)	 LOGO command    CS    clears the drawing screen.
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		  (b)	� The COUNT command counts the number of characters in 
a word.

		  (c)	� LOGO command PU moves the turtle without drawing and 
the PD command brings the turtle back to the drawing 
mode.

		  (d)	� The SHOWTIME command displays the current date and 
time of the computer system.

		  (e)	 The   PE   command erases lines under the turtle’s path.

2.	 Tick () the correct option.
	Ans.	 (a)	� This LOGO command clears the contents of the Command 

Input box.
	 (i)	 CS			   (ii)	 CLEARSCREEN
	 (iii)	 CLEAN			   (iv)	 CT
		�  (b)	 Which of the following is not a valid LOGO command?
	 (i)	 CLEARSCREEN	 (ii)	 CLEANSCREEN
	 (iii)	 PENUP			   (iv)	 PENDOWN
		  (c)	� Which of the following commands converts capital letters 

into small letters?
	 (i)	 LOWERCASE		 (ii)	 SMALL
	 (iii)	 SMALLCASE			  (iv)	 CAPITALCASE
		  (d)	� The output of which of the following commands will be 

blank?
	 (i)	 FD 40 RT 90		 (ii)	 BK 30 
	 (iii)	 FD 20 PU FD 20 PD FD 20	(iv)	 FD 40 PE BK 40
		  (e)	� Which of the following LOGO commands moves the turtle 

without drawing?
	 (i)	 PENUP			   (ii)	 PENAIR
	 (iii)	 PENLIFT			   (iv)	 PENPAINT
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3.	 Answer the following questions.
	 (a)	 Give one example of the PENUP command in LOGO.
		  Ans.  FD 20 PU FD 20 PD FD 20
	 (b)	� How will you erase a line drawn with the help of the command 

	 FD 45?
		  Ans.  FD 45 PE BK 45
	 (c)	� Which LOGO command brings the turtle back to the drawing  

	 mode after erasing a line?
		  Ans.  PENPAINT

	(d)	� With the help of an example, show how the word COMPUTER 
in capital letters can be converted into the word computer in 
small letters?

		  Ans.  SHOW LOWERCASE “COMPUTER
	 (e)	� What will be the output of the LOGO command SHOW TIME?
		  Ans.  It will show the current date and time. For example:  

   [Mon Nov 25 08: 35:10 2019]

Computer Time

Try each of the following commands and draw the outputs in the 
given boxes.
	Ans.	 Do it yourself.

Answers of Suggested Class Activities
	1. (c)  2. (b)  3. (a)  4. (c)  5. (a)

Answers of Worksheet
	 I.  	 1.  COUNT  2.  SHOW UPPERCASE
		  3.  SHOW  4.  PENPAINT  5.  CLEARTEXT
	 II.  	 1.  True  2.  False  3.  True  4.  False  5.  True
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Chapter 8
The Internet

Do and Learn
	 1.	 Fill in the blanks.
	Ans.	 (a)	 A computer network can be defined as two or more 

computers connected together.
		  (b)	 World Wide Web is also called the Web.
		  (c)	 Each page of a website is called a Web page.
		  (d)	 You can watch movies and cartoons through the Internet.
		  (e)	 Electronic letters sent over the Internet are called e-mails.

	 2.	 State whether True (T) or False (F).
	Ans.	 (a)	 The Internet is very useful.	 T
		  (b)	 It can be used to send messages anywhere in the	  
			   world.	 T

		  (c)	 The World Wide Web is also known as chatting.	 F
		  (d)	 Websites contain information in the form of text, 
			   pictures, etc.	 T

		  (e)	 We can operate our bank through the Internet.	 T 	
	 3.	 Find out four terms related to the Internet from the grid.
 	Ans.	 S K M V L I I T Y W

X V E T L B N E M E
P W E B M V T M E B
S G O P A S E C L P
H R Y A G E R I V A
I B M C P R N D T G
F R L E Z V E O E E
T S V B W E T J Z A
E S L A Q R Q T U O
X W E B S I T E N D
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4.	 Answer the following questions.
	 (a)	 What is networking?
		  Ans. � A computer network or networking can be defined as two 

or more computers connected together in order to share 
information and resources.

	 (b)	 Give an example of a web browser.
		  Ans. � Google Chrome.
	 (c)	 How is a website different from a web page?
		  Ans. �� A website can be made up of text, images and other 

things. The information given on a website is generally 
divided into several pages. Each page is called a Web 
page.

	 (d)	 Mention any two uses of Internet.
		  Ans. � 1. � It helps us to share information from any place in the 

world.
				    2.  It is a source of information for everyone — those who 

are learning or teaching as well as those who are 
doing different jobs.

				    3.  It enables fast transfer of news to people all over 
the world.(Any two)

		  (e)	� Name any website that can be used for searching on the 
Internet.

		  Ans.  Google.com

Computer Time

With the help of your parents/teacher, open the Internet and find 
information about the following topics. Write 10 lines about each 
in your notebook.
	 1.	 Your favourite cartoon character
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	 2.	 Save water
	Ans.	 Do it yourself.

Answers of Suggested Class Activities
A. F F B V V W T G R H I

A W Y S U W N Y U D I
C H I N S T A G R A M
E A Y P L B K V Z D K
B T X P F P Q T G B B
O S S N A P C H A T A
O A M A Z S E P O Y W
K P R E Z D O G F X N
R P A F G V B T C I F

B. 	1. WEBSITE  2. EMAIL  3. SERVER  4. WEB PAGE
	 5.	 BROWSER
C. 	1. (c)  2. (d)  3. (e)  4. (a)  5. (b)

Answers of Worksheet

	 I.  	 1.  Internet Explorer  2.  Home page  3.  Web browser
  		  4.  Web browser  5.  Network.
	 II.  	 1.  False  2.  True  3.  True  4.  False  5.  True
	 III.  	 1.  (d)  2.  (d)  3.  (a)  4.  (d)  5.  (d)
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Chapter 9

Fun with Scratch

Computer Time

Try the following steps in Scratch.
	Ans.	 Do it yourself.

Do and Learn

1.	 Fill in the blanks.
	Ans.	 (a)	 Scratch is a computer language.
		  (b)	 The Globe button is used to change the interface language.
		  (c)	 The large white area on the Scratch window is called stage.
		  (d)	 The default sprite in Scratch is a cat.
		  (e)	 We can select a readymade sprite from the library.

	 2.	 Tick () the correct option.
	Ans.	 (a)	� Which of the following is used to move the sprite 30 steps 

back?

	 (i)	 stepsmove 10 	 (ii)	 stepsmove 30

	 (iii)	 degreesturn 30 	 (iv)	 stepsmove –30

		  (b)	 Which of the following is the default sprite in Scratch?
	 (i)	 Dog			   (ii)	 Cat
	 (iii)	 Lion			   (iv)	 Camel
		  (c)	 Which of the following is a computer language?
	 (i)	 LOGO			   (ii)	 Scratch
	 (iii)	 MS Word			   (iv)	 Both (i) and (ii)
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		  (d)	� Which of the following commands help you save your 
project in Scratch?

	 (i)	 File → Open			   (ii)	 File → Exit
	 (iii)	 File → Save	 		  (iv)	 File → Open
		  (e)	� Which of the following buttons do you press to open the 

Sprite Library?

	 (i)	 			   (ii)	

	 (iii)	 			   (iv)	

	 3.	 State whether True (T) or False (F).

	Ans.	 (a)	 Sprite is a computer language.	 T

		  (b)	 We cannot change the sprite present on the stage.	 F
	 	 (c)	 �The file menu consists of the commands to open an existing 

project, create a new one and save a project.	 T

		  (d)	 The Globe button is the Scratch logo.	 F

		  (e)	 A script can move a sprite on the stage.	 T

	 4.	 Answer the following questions.
	 (a)	 What is Scratch?
	Ans.	� Scratch is a computer language used for creating games, etc.

	 (b)	 Write the steps to open Scratch on your computer.
	Ans.	 The steps to open Scratch are as follows:
			   (i)	 Click on the Windows button.
			   (ii)	� Using the Search option, search for Scratch from the 

	 keyboard.
			  (iii)	 Click Scratch 2.
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	 (c)	 What is the purpose of green flag button in Scratch?
	Ans.	 The green flag button is used to run a project.
	 (d)	� From where do we get different types of readymade sprites in  

	 Scratch?
	Ans.	 From the New sprite button and choose library.
	 (e)	� What is the purpose of the Duplicate button on the menu bar?
	Ans.	� The Duplicate button is used to make a copy of a block or 

sprite.

Computer Time

	Ans.	 Do it yourself.

Answers of Suggested Class Activities
A. 	1. (c)  2. (d)  3. (b)  4. (a)
B. 	The correct order is: 2, 3, 1, 4.

Answers of Worksheet

	 I.  	 1.  (b)  2.  (a)  3.  (c)  4.  (d)  5.  (c)
	 II.  	 1.  Edit  2.  Scratch  3.  Object  4.  Green  5.  Stage
	 III.  	 1.  True  2.  False  3.  False  4.  True  5.  False
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TESTING TIME 3
(Based on Lessons 7 to 9)

1.	 Match the following:
	Ans.	 1.	 CT	 (a)	Computer language
		  2.	 SHOW	 (b)	Increases the sprite size
		  3.	 E-mail	 (c)	Erases the text in  
					    the Command Input Box
		  4.	 Scratch	 (d)	Prints the input message
		  5.	 GROW	 (e)	Sending letters through  
					    the Internet

2.	 From the following word grid, find five LOGO primitives.

S N T E R N E T Y U
H V E T L B X E D P
O W E B M P E N U P
W G O P A S M C L E
H R Y H G E U I E R
I B M O P R Z D T C
F R L M Z V A O E A
T S V E W E P J Z S
E S C A Q R Q T U E
C O U N T K T E N Q

3.	 Name the following.
	Ans.	 (a)	� LOGO command to bring the turtle to the drawing mode. 

	 PD
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		  (b)	� LOGO command to get the turtle to its starting				  
position.	 HOME

		  (c)	� Collection of web pages on the Internet.	 Website
		  (d)	� Scratch button used to change the interface	  

language.	 Globe
	 	 (e)	 �Readymade figures on the Scratch stage.	 Sprite

4.	 Answer the following questions.
	 (a)	What is the purpose of the PENPAINT command in Logo?
	Ans.	� To bring the turtle back to drawing mode after erasing using the 

PE command.
	 (b)	�Can we use a Logo command to get the current date and time 

on the screen? How?
	Ans.	 Yes, by using the SHOWTIME command.

	 (c)	 Mention any three uses of the Internet.
	Ans.	  (i)	�It helps us to share information from any place in the world.
		  (ii)	�It is a source of information for everyone — those who are  

learning or teaching as well as those who are doing  
different jobs.

		  (iii)	�It enables fast transfer of news to people all over the world.
	 (d)	 Write full forms of:
	Ans.	  (i)	WWW: World Wide Web         (ii) E-mail: Electronic Mail
	 (e)	 Write the steps in Scratch to move the cat sprite 30 steps forward  
			  and then turn it left 80 degrees.

	Ans.	 stepsmove 30

↓

		  degreesturn 80

PROJECT WORK
	Ans.	 Do it yourself.
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